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Tableau Public Workshop Handout

This handout was developed with Tableau 2021.2 by Jane Zhao,
|anezhao@rice.edu on Friday, July 9, 2021.

Objectives
Participants will be able to
1) tell the limitations of Tableau Public
2) describe how to connect to an Excel file
3) understand how Tableau manipulates data and how Tableau works
4) be able to create basic charts such as line chart, bar chart, and text table.
5) create a worksheet, a dashboard, and a story
6) know how to create a group, a hierarchy, and an interactive filter
7) save work to Tableau Public website
8) share the created charts

Outline
1. Workshop objectives
2. Introduction
3. Preparing Data: Data extraction and transformation
4. Using Tableau Public
I.  Connect to your data
Il.  Create a bar chart with one measure and one dimension
i. Dimensions and measures
ii. Demonstrate how Tableau manipulates data
iii. Show Me menu
iv. Create a bar chart with one measure and one dimension
v. Sort data
. Use the Marks card to add depth to your chart
i. Create a bar chart with one measure and two dimensions
ii. Create a circle chart with one measure and two dimensions
iii. Create a text table with one measure and three dimensions
IV.  Drill down into the data
i. Drill down the date and time hierarchy
ii. Create groups and form custom hierarchy
V. Filter data from your view and add interactive filters
VI.  Use Dashboard to uncover key insights
VIl.  Use Story to present your analysis
VIIl.  Save and publish your work
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Introduction

® Tableau is a data visualization tool that can help you understand data and
discover insights of data. With Tableau, you can create beautiful charts, graphs,
dashboards and share them with other people conveniently.

® Tableau products
O Tableau Desktop

®  The full version of Tableau.
® |t can connect to a wide array of data sources.

® |t has very strong security for data.
O Tableau Prep Builder

® A brand-new data preparation product designed to empower people
to quickly and confidently combine, shape, and clean their data.
When it was first released in April 2018, it was named Tableau
Prep.

» Then Tableau Prep version 2019.1. 2 had changed its name
to Tableau Prep Builder.

» Tableau public doesn’t include Tableau Prep Builder.

O Tableau Server
It is for an organization analytical use, available to those who can support

a server that is dedicated to Tableau. There's a very large financial
investment for an organization.

O Tableau Online

It is the cloud solution for an organization. It doesn't require a large
investment of money into a server. It needs accounts setup.

O Tableau Public

Tableau Public is a free solution/service from Tableau Software Company.
It involves two products.

®  Tableau Desktop Public — the free version of Tableau Desktop with
limitations.

® The work can’t be saved locally. The work can only be saved
to the Tableau Public website (i.e. Tableau Public Server).
Data privacy caution: Make sure you remove any
confidential data such as SSN and ID or private data
such as personal financial information before you save
and publish a workbook.



® |t works with data from Microsoft Excel, multiple text file
formats, statistical files, Google sheets and web data
connectors. It doesn’t connect to databases.

® A free Tableau Public account is limited to 10GB online
storage and 15,000,000 rows of data per workbook.

®  Tableau Public (Server): It is the free version of Tableau Server
hosted by Tableau Software company. It requires all workbooks are
feely accessible to everybody. You have the option to prevent
people from seeing the underlying data (i.e. your original data)
though.

B To use Tableau Public,

® (Create an account on Tableau Public at
https://public.tableau.com/s/

® Download Tableau Desktop Public edition at
https://public.tableau.com/s/download
o Tableau Academic Programs
Tableau Desktop and Tableau Prep Builder are free for students and
instructors around the world.
» Tableau for Students
Students (K12 and postsecondary) at accredited academic
institutions worldwide are eligible for a free one-year license to
activate Tableau Desktop and Tableau Prep Builder. Fill out a form
at https://www.tableau.com/academic/students - form
» See Tableau Academic Programs for more information at
https://www.tableau.com/academic

Preparing Data: Data Extraction and Transformation

Preparing data can be very time consuming and intimidating! Your data needs to be
correctly prepared. If the data is not prepared correctly, it will be hard for Tableau to
recognize and utilize for analyses. Fortunately, we don’t have to do anything for the data
used in this workshop. The DMC equipment circulation dataset is ready for use. It was
prepared by Mang Sun, Fondren System Librarian. He extracted the data from Sirsi’'s
system log file, and transformed it into an Excel spreadsheet file.
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The Tableau Workflow

I. Connect to your data
1) Load a data file

The first step is to connect to the data you want to explore or visualize. Launch Tableau
Public .

a. Connecting to a data file
¢ Loading a local Excel file.
1) On the left hand side blue navigation area, Connect
a. ToacFile
b. Excel ->, locate the .xIs file you want to open
2) Or File -> Open, locate the .xIs file you want to open.
e Loading an online Google Sheet
o To a Server
o More... -> Google Sheets
o Input your Google Account and password
o Tableau will ask to have access to:

GO gle ricedmc@gmail.com -

~ Tableau Desktop would like to:
L View the files in your Google Drive
View your email address
View your basic profile info

By clicking Allow, you allow this app and Goagle to use your information in
accordance with their respective terms of service and privacy policies. You can
change this and other Account Permissions at any time.

o Click Allow to continue
o Then select the Google Sheet you want to connect, click Connect to
continue.
¢ Once the file is connected successfully, you will see Tableau load the first
1000 records for preview.
2) Verify the automatically assigned data type

After the data is connected, the column headers from your data source are shown as
fields. Tableau assigns each field a data type. The data type reflects the kind of
information stored in that field, for example, dates (9/18/2017) and strings (“Rice
University”). In this DMC equipment circulation data set, User Profile is set to String,



User Catl is set to String too. However, Time Charge is set to String (Abc), which is
wrong. The wrong default data type needs to be corrected. Click the Abc symbol above
Time Charge and select Date and Time.

& | € o

- DMC-charges-2014-2016 (DMC-equipment-circulation-data) Filters
0

Connections Add

Microsoft Exce!

DMC-charges-2014-2016
Sheets =)

Use Data Interpreter

| DMC-equipment-circulation-data

Data Interpreter might be able to

Need more data?
clean your Microsoft Excel

workboak. Drag tables here to relate them. Learn more
EH DMC-charges-2014-2016 | = sortfields | Data source order - Show aliases Show hidden fields | 1,000 rows
Hbe abe Abe Abe - mbe abe Abe
= New Union User Profile User Catl User Cat2 Number (decimal) e Station Operator Barcod
Number (whole)
GRAD GRAD STUDENT Date & Time 5E DMCSTUDNT 312
GRAD GRAD STUDENT Date 5E DMCSTUDNT 312
+ String
GRAD GRAD STUDENT Boolean 3E DMCSTUDNT 312
STAFF STAFF STAFF + Default 3E DMCSTUDNT 312
GRADUATE1S GRAD1S STUDENT Geographic Role  » E DMCSTUDNT 312
GRADUATELS GRAD15 STUDENT 01/03/2014 14:25:22 CHARGE DMCSTUDNT 312
GRADUATELS GRAD15 STUDENT 01/06/2014 16:23:42 CHARGE DMCSTUDNT 31z
Gi ~ Wnrke e3
il GotoWorksheet GRADUATE1S GRAD15 STUDENT 01/06/2014 16:23:46  CHARGE DMCSTUDNT 312

N

The table below shows the Data Types in Tableau.

Icon Data type

Abe Text (string) values

B Date values

Ea Date & Time values

H Numerical values

TIF Boolean values (relational only)

il Geographic values (used with maps)

Note: Tableau is only referencing the source data. When you work the data within Tableau, your
underlying data won’t be affected. Your original source data remains intact.



[I. Create a chart with one measure and one dimension
Activity 2.1 Understanding Dimensions and Measures in the Data Pane
1) Click Sheet 1 at the left bottom next to Data Source.

B Data Source Sheetl | i HL O}

2) After the data is loaded, the column headers from your data source are shown as fields.
Tableau automatically assigns a data type to each field. It also automatically assigns a
role, a Dimension role or a Measure role, to each field.

3) Dimensions and Measures in the Data pane.

a. Dimensions are displayed above the gray line, and measures below the gray line.
We build charts/visualizations by adding fields from the Data pane to the view.

b. Dimensions are qualitative fields. They typically hold categorical or descriptive
data that can’t be aggregated such as title/call numbers, dates or Boolean
values. Dimensions set the granularity, or the level of detail in the view. We
typically want to group our data by some combination of categories. What
dimensions we use to build the view will determine how many marks we
have. A mark is a visual representation of a row or a group of rows in your data
source.

c. Measures are quantitative fields. They hold numerical data that can be
measured and aggregated such as number of charges and sales. They’re
aggregated up to the granularity set by the dimensions in the view. The
value of a measure therefore depends on the context of the dimensions. It
provides the measurement for qualitative category.

d. Dimensions come out onto the view as themselves, measures come out
onto the view as aggregates, discrete pills are BLUE, continuous pills are
GREEN. When the field is continuous, Tableau draws an axis for the chart.
When the field is discrete, it draws a label, or a header, instead of an axis.

e. Dimension fields are generally used for row or column headings. Measures are
generally used for plotting or giving values to the sizes of markers.

4) Italic fields are automatically generated by Tableau.

Activity 2.2.01 Understand how Tableau manipulates data
Question: How to break down the total number of charges by year by User Profile?
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1) Drag a measure Number of Charges to the view area, you will see a number 13,178 in
the view. When we drop a field on the Drop field here grid, we are creating a view from a
tabular perspective.

2) What Tableau does here is to add the Number of Charges in the table. The default
aggregation applied is Sum.

3) If we want to see the year in this view, drag Time Charge to Columns shelf. Now we
have broken down our single number into three numbers. Basically we have sliced the
aggregated number by year. When we add a dimension to the view, members of that
dimension will be added as column or row headers.

iii Columns YEAR(Time Charge)

= Rows

Sheet 1

Time Charge
2014 2015 2016
4,084 4,113 4,981
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4) If we would rather have row headers, we can drag the YEAR pill to Rows.

iii Columns
= Rows YEAR(Time Charge)
Sheet 1

Year of Tim..

2014 4,084

2015 4113

2016 4 981

Drag YEAR pill back to the Columns shelf.

5) If we would like to put User Profile, we drag it to the Rows shelf. Now we see we have
further broken down the three numbers. We got a table of 13 rows and 3 columns,
including 29 numbers and 10 null values.

i Columns
= Rows

Sheet 1
Time Charge

User Profile 2014 2015 2016
FACULTY 154 161 132
GRAD 343 703 1,035
GRADUATE14 411

GRADUATE1S §70 428
GRADUATE1G 692 802 517
INACTIVE 11

INSIDE1S 25 9 20
LIBRARYUSE 3

OUTSIDE4 3 &
OUTSIDELS 3

STAFF ag2 576 709
TERMINATED 333 178 44
UNDERGRAD 677 1,250 2,518

6) Atany time, you can right click over a number and choose View Data... to view the
underlying sliced data.

7) You can drag both YEAR pill and User Profile to either Columns shelf or Rows shelf.
However, this probably will generate either too long or too high table that you have to
scroll to view. That's what you want to avoid.

8) Right click over Sheet 1 and rename it to DMC-Charges-byYear-byUserProfile-Table.

Activity 2.2.02 Understand Show Me menu
1) Consider Show Me to be your expert helper. Show Me tells you what chart to use and
why.
2) Show Me menu lists 24 common chart types. Some of them will be available. Some of
the them will be greyed out depending on the context.
Note: It's possible to build an enormous variety of charts in Tableau, Show Me is one-
click options, not a comprehensive list of possibilities.



3)

4)

5)

6)

7

8) Charts are most effective and readable when matched to the right data and purpose.

Show Me creates a view based on the fields already used in the view and any fields
you’ve selected in the Data pane.

Tableau automatically evaluates the selected fields and gives you the option of several
types of views that would be appropriate for those fields. Show Me also highlights the

visualization type with orange color that best matches the data.

Chart types that are not applicable to your worksheet as it is currently constructed will be

grayed out and not selectable until you have the appropriate combination of measures

and/or dimensions.

Any view type that is not greyed out will generate a view of your data. As you hover over

each view type, the description at the bottom shows the minimum requirements.
In this example, because a date dimension and a measure are selected, Tableau

suggests you build a line view. A line is often the optimal way to look at how measure

values change over time.

- - 5 2 IF £- T, f# | Standard ~ - o8 = ShowMe
Pages jii Columns @ YEAR(Time Charge) .
= Rows ‘SUM(Number of Reco.. L O ] &
Fiiters .
Sheet 2
Time Charge __— IEI
— I 1
Marks 5000 == | O
s - S
of Bar -
44 o @ s | -
Color | Size | Label ~~
| 2 soc0 [N T >
Detail | | Tookip
*: QI il
for °
‘ "
I W [
For stacked bars try
PO Divrsiors

sormors QTEED)

Number of Records

2014 2015 2016

a. Line chart — view trends in data over time

b. Bar chart — compare data across categories

c. Circle chart - show data in a proportional manner. People are drawn to using
circles because the varied size of circles provides meaning about the data.

d. Histogram — understand the distribution of your data

e. Scatterplot — determine correlation between two measures

Activity 2.2.1 Visualizing the total number of charges by year via bar chart
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Question: What is the total number of charges each year? How did one year compare to
the other two years?

m| B o0
1) Create a new worksheet by clicking on New Worksheet button New Worksheer .
2) Drag Number of Charges from Measures to the Rows shelf

a. When we bring a field into the view from the data pane, Tableau creates a pill.

b. The Number of Charges field is colored green on the Rows shelf, indicating that it
is continuous.

c. The field name changes to SUM(Number of Charges). That’s because measures
are automatically aggregated when you add them to the view, and the default
aggregation for this measure is SUM.

d. If you right-click over SUM(Number of Charges), select Measure (Sum), you will
see all the Aggregate functions available for this measure.

Data Analytics ¢ Pages jii Columns
f§, DMC-charges-2014-20. = Rows SUM(Number of C.. ~
. Filter...
P IEEL Y | Filters
Tables Sheet 2 Show Filter
she  Barcode Format...
abe Op Type +/ Show Header
abc Station Operator Marks 12K + Include in Tooltip
3 Time Charge ol Automatic - Dimension
abe Title/Call No. ;
abc User Catl : & 10K v (Sum) »
User Cat2 Color Size Label - + Sum
Abe ser La
) 0 Discrete Aver‘age
abe  User Profile oda [ N Median
- . w
b Measure Names Detail | | Tooltip & o o/ R LILETE Count
4 Number of Charges g Edit in Shelf Count (Distinct)
#  DMC-charges-2014-201... o Add Table Calculation... Minimum
4 Measure Values £ ek Quick Table Calculation ~ » | Maximum
=] "
= Percentile >
Remove Std. Dev
» Std. Dev (Pop.)
Variance
Variance (Pop.)
2K
0K

i. SUM - Returns the sum of all values in the expression.

ii. AVG - Returns the average of all the values in the expression (i.e. the
sum of a collection of values divided by the number of values in the
collection.). In our example, SUM (number of charges) / COUNT (number
of charges) =1

iii. COUNT - Returns the number of items in a group. In our example, the
count number is the same as the sum number.

iv. COUNTD - Returns the number of distinct items in a group. In our
example COUNTD is 1.

v. Read more at Aggregate Functions in Tableau .

11


http://onlinehelp.tableau.com/current/pro/desktop/en-us/help.html#calculations_calculatedfields_aggregate_create.html%3FTocPath%3DDesign%2520Views%2520and%2520Analyze%2520Data%7CAdvanced%2520Analysis%7CCalculated%2520Fields%7CAggregate%2520Calculations%7C_____2

3) Drag Time Charge from Dimensions to the Columns shelf. Tableau creates a line chart
by default. Remember line chart is good to view trend in data values over time. We want
to compare data across years, so change the Marks from Automatic to Bar.

a. When you drag a field over a shelf, a plus sign indicates that the shelf can accept
the field.

b. Notice that the field is colored blue, which indicates that it is discrete.

c. Dimensions set the granularity, or the level of detail in the view. What dimensions
we use to build the view will determine how many marks we have. Here we have
3 years of data, 2014-2016 — and we have 3 marks.

d. The default date level is determined by the highest level that contains more than
one distinct value (for example, multiple years and multiple months). That means
that if [Time Charge] contained data for only one year but had multiple months,
the default level would be month.

Data Analytics +  Pages jii Columns YEAR(Time Charge)
[ tbldmecharge (tableau-d... = Rows SUM(Number of Char..
Dimensions EHE L -
Filters
abe Barcode DMC-Charges-By-Year
Abe Op Type
© Sphe Time Charge
abc Station Operator
) 5K
Time Ch “’
£ Time Charge Marks
abc Title/Call No.
sbe User Catl
4K
abc  User Cat2 s 5}
Abe  User Profile Colar Size Label
abe Measure Names a
N 5 3K
Detail | | Tooltip S
k]
@
L0
5
E 2K
Measures
=4 Number of Charges
#  Measure Values 1K

0K
2014 2015 2016

4) Right click over Sheet 2 and rename it to DMC-charges-by-year.
5) Optional steps
a. Right click over the sheet name, choose Duplicate as Crosstab, you will get a
text table (Crosstab) just like the one created in the previous activity. The text
table shows the numbers visualized in the view. Right click over the sheet name,
choose Delete to delete the sheet.
b. Or click on Show Me, choose text tables, you will get the same text table as the
action of Duplicate as Crosstab.
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Activity 2.2.2 Visualizing the total number of charges by month via bar chart
(one measure and one dimension)

Question: What is the total number of charges each month across years?

1)
2)

3)

4)

5)

1)
2)

3)
4)
5)

m

Click * to create a new worksheet.

Drag Number of Charges from Measures to the Rows shelf and Time Charge from
Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-down
menu.

Click the Down arrow in the YEAR(Time Charge) pill on the Columns shelf and select
Month (the first one, the Discrete one).

You will get checkout numbers by month

Data Analytics 4 | Pages iil Columns MONTH(Time Char..
[_{.5. DMC-charges-2014-20... = Rows
Search P IEEL Y Filters

DMC-Charges-by-Month
Tables
#be Barcode
Ak Op Type Time Charge

she Station Operator Marks

£ Time Charge 1ol Bar
ape Title/Call No. .
ane User Catl - & ™

abe User Cat2 Color Size Label

sbe  User Profile oo [

tbe  Measure Names Detail | | Tooltip

4 Number of Charges 1000

#  DMC-charges-2014-201...

4 Measure Values |
SRR

2w
i

=

Mumber of Charges

=
=1

a

&
5

I

Rename the sheet to DMC-charges-by-month.

mi

Click to create a new worksheet.

Drag Number of Charges from Measures to the Rows shelf and Time Charge from
Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-down
menu.

Choose Weekday from the Time Charge pill drop down menu this time.

You will get checkout numbers by Weekday.

Rename the sheet to DMC-charges-by-weekday.
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1) Right click over the sheet of DMC-charges-by-weekday

2) Select Duplicate

3) Click the Down arrow in the Year(Time Charge) pill on the Columns shelf, select More
and click Hour

4) You will get checkout numbers by Hour.

5) Rename the sheet to DMC-charges-by-hour.

Note: On the Time Charge field drop down menu, the first set is for discrete date levels and the
second list is for continuous date levels. Discrete means data is individually separate and
distinct. Continuous means data can take any value in a range, forming an unbroken
whole, without interruption. Dates can be brought into the view as either continuous or

discrete.
il Coumns

. Filter...
i Rows

Show Filter
Sheet 1 Show Highlighter

Sort...
Format...
+ Show Header

5000 - .
+ Include in Tooltip

Show Missing Values

Quarter Q2
Month May
Day B

4000

ﬁure »
iscrete date level
Year 2015

Quarter Q2 2015
2000 Month May 2015
Week Number Week 5, 2015
Day May 8, 2015

More [ 3
ntinuous date level
Exact Date

2500

Number of Charges

Attribute
Measure >

2000

+ Discrete
Continuous

Edit in Shelf

1500
1000

500

2014 2015 2016

Activity 2.2.5 Sorting data

e In the DMC-charges-by-hour, click Swap Rows and Columns button on the
toolbar to make the bars horizontal.
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Number of Charges =1
e Hover over the mouse over the sort icon . One click sorts

the data in ascending order. Two clicks sort it in descending order. Three clicks clear the
custom sort, setting it back to the default sort method.

=
=

e Oron the toolbar, click the Descending sorticon * -  to sort data from highest/most to

=]
=
=

lowest/least, or the Ascending icon to do the other way around.
e Or select an hour in a header and drag it up or down, the viz updates with the new sort.

In any way, Tableau provides a visual indication that a customized sort is applied. A sort
icon appears on the HOUR (Time Charge) (on rows).

BIF £~ T ff |FrHegmt = - == A 4 = Show Me

LI AR O oS custom sort icon

= Rows B HOUR(Time Ch.. &

DMC-Charges-By-Hour

Hour of Tim.

‘
=]
=]

Number of Records =5

lll. Use Marks card to add depth to your chart
Activity 3.1 Visualizing the total number of charges by year and by user
profile via bar chart (one measure and two dimensions)

Question: What is the total charges each year and what is the total charges for each user
group each year?

[
1) Click to create a new worksheet.
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2)

3)

4)

5)

6)

Drag Number of Charges from Measures to the Rows shelf and Time Charge from
Dimensions to the Columns shelf, and make sure Bar is selected in the Marks Pull-down
menu.

Drag and drop User Profile from Dimensions on to the Color card in the Marks pane.
Note: The Marks card is where you drag fields to control mark properties such as type,
color, size, shape, and so on.

You can get the following screen. The Color legend is on the right side.

Data Analytics s Pages iii Columns

f& DMC-charges-2014-20..

= Rows SUM(Number of Char..
Search P|EE| - Filters User Profile
Sheet 5
Tables W FAcULTY
#be Barcode Time Charge GRAD
e OpType 5K W GRADUATE14
#be  Station Operator Maks GRADUATELS
£ Time Charge woll Bar . M GRADUATE16 |
abe Title/Call No. . INACTIVE
abe User Catl o ;9 LI aK I M nsIDELS
b User Cat2 = = = LIBRARYUSE
. M cuTsIDE4
abe  User Profile ofo (]
ke Measure Names Detail || Tooltip [ ouTSIDE1S
3K W sTAFF

+  Number of Charges B User Profile

++  DMC-charges-2014-201...
4 Measure Values

TERMINATED
B UNDERGRAD

Number of Charges

™
=

n
=1
[
o

2014 2016

Placing a dimension on Color separates the marks according to the members in the
dimension and assigns a unique color to each member. The color legend displays each
member name and its associated color.

Rename the sheet to DMC-Charges-by-year-UserProfile.

Question: What is the total charges each year and what is the total charges for each
equipment category each year?

1)
2)

3)
4)

Create a new worksheet.

Drag Number of Charges from Measures to the Rows shelf and Time Charge from
Dimensions to the Columns shelf.

Select Circle in the Marks Pull-down menu.

Drag Equipment Category on to the Color card. Then drag Number of Charges on to the
Size card.
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5) You can also click the Size card to adjust the size of circle via the popped-up Size
1,100

Iarks
O Circle - 1.000
H- IR
Color Size Label \ /
ato I 8§55
Detail o
L 1) i
= Equipment .. a00
F3]  SUM(Number .
822

700

rof Charges

. . &l
selection slider. 656

6) Rename the sheet to DMC-charges-by-year-EquipmentCategory.

1) Create a new worksheet.
2) Select Number of Charges from Measures and Time Charge, User Profile and

Equipment Category from Dimensions,
3) Click the text tables button on the Show Me Tool Bar.

/ = Show Me

(R IS 4 | | . L
- N
N

4) Now you get statistics in tabular format.

IV. Drill down into the Data

Drilling down usually means expanding out a hierarchy, getting to the next level of
detail. When you connect to a data source, Tableau automatically separates date fields

into hierarchies so you can easily break down the viz. You can conveniently traverse (drill
down and scroll up) along Tableau generated Date and Time Hierarchy and watch change on

numbers.



Activity 4.1 Drilling down date hierarchy with the DMC-Charges-by-Year
chart

You can modify the view to show quarters, month, etc. in addition to years. As you drill
down into the hierarchy, the view changes to become a nested table.

1) Right click over the sheet of DMC-Charges-By-Year.
2) Select Duplicate.

_ YEAR(Time Charge) _
3) Click the plus button on the left side of the

field YEAR(Time Charge) field on Columns.
4) The new expanded dimension divides the view into separate panes for each year.
5) You can further drill into months. And delete QUARTER (Time Charges) from the

Columns shelf.
i Columns
= Rows

Sheet 2

Time Charge
2014 2015 2016

700

g

o

2 a00

5

2

5

5

2

E 350

Z

200

: IIII III
0
228:zg85=" 2gE e85 5= izBse

6) Rename the sheet to DMC-Charges-by-Year-Month

7) Switch YEAR(Time Charge) and MONTH(TIME Charge) in Rows by dragging
MONTH(TIME Charge) to the front of YEAR(Time Charge), you will see the nested table
is changed to the view below. Tableau generates a view based on where and in what
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order you drag and drop fields into the shelf.
B IF £- T) f FitHeight ~| Ea- TJ | of

il Courmns

= Fows

DMC-Charges-By-Year-Month

Time Charge
January February March Apri May June July August Septemb.. October [November December

700

ug
400
300

.e

8) Click Undo button on the toolbar to undo the change.

Mumber of Records

r

=
a8

o

Activity 4.2 Creating groups and drillable hierarchy

You can also create your own custom hierarchies. For example, if you have a set of
fields named Region, State, and County, you can create a hierarchy from these fields so
that you can quickly drill down between levels in the viz.

Activity 4.2.1 Create Groups

Group simplifies large numbers of dimension members by combining them into higher-
level categories. The field “User Profile” has too many members. Let’s bring it down to 4
groups (i.e. students, faculty, staff, and others.). This creates a higher-level category.
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1) Inthe Data pane, right-click User Profile and select Create > Group...

Data Analytics ¢ | Pages jii Columns

[ DMC-charges-2014-20. = Rows

£ EL T Fiters
Sheet 11
Tables
ane Barcode
Ao OpType
sbc Station Operator Marks
£z Time Charge [T Automatic =
ape Title/Call No. .
ape User Catl &
Color Size Text
#be User Cat2
#be  Measure Narmes Add to Sheet
4 Number of Charges Duplicate
4 DMC-charges-2014-201... Rename
4 Measure Values
Aliases...
Create Ll Calculated Field...
Transform 2 Group...
Convert to Measure =ik

Change Data Type > Para.meler...

Geographic Role 2
Default Properties >

2) Inthe Create Group dialog box, select GRAD, GRADUATE14, GRADUATE15,
GRADUATE16, GRADUATE17, UNDERGRAD that we want to group, and then
click Group. Name it STUDENTS.

[ ] [ ] Create Group [User Profile]

Field Name: User Profile (group)

Croups: Add to:

<

FACULTY
Bl s TuDENTS
GRAD
GRADUATE14
GRADUATE1S
GRADUATE16
UNDERGRAD
INACTIVE
INSIDE15
LIBRARYUSE
OUTSIDELS
OUTSIDE4
STAFF
TERMINATED

Group Show Add Location

Include 'Other' Find >>

Reset Apply Cancel

3) Select INACTIVE, INSIDE15, LIBRARYUSE, OUTSIDE4, OUTSIDE15, TERMINATED,
then click Group. Name it OTHERS. Click OK button on the Create Group window
dialogue box to close it.
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4) You will see a new dimension User Profile (group) is created and put under Dimensions.
Right click over its name and rename it to User Profile Groupings.

Activity 4.2.2 Form hierarchies
Hierarchies give end users the option to look at data at a high level or drill down into more
detailed levels. We will create a hierarchy with User Profile Groupings and User Profile. Since
‘User Profile Groupings’ is a higher level of categorization of ‘User Profile’, it makes sense to
have this before ‘User Profile’, on the top of the hierarchy.

1) Under Dimensions, drag User Profile on top of User Profile Groupings.

Dimensions L~
Filters
Abc  Barcode
Op Type
anc  Station Operator
Time Charge
2 Marks
Anc Titie/Call No o
b "
ave User Catl b ;;.'/ 2ol Bar v
avc User Cat2 'l‘é;/-?"r e (,) —
g - . —
Ao User '-’rqf.l_em_. . “ Salor Size Label
| el
ave  Measure Names
Detail Tooltip
b User Profile Gr..

2) Change the name of the hierarchy to User Profile Hierarchy.
v & User Profile Hierarchy
& User Profile Groupings
Abc  User Profile

3) Build a view by dragging Number of Charges to Columns shelf and User Profile

Groupings (or User Profile Hierachy) to Rows shelf. You will see the + sign in front of the
User Profile Groupings pill.

iii Columns SUM(Number of Char..
= Rows | ser Profile Groupi..

Srggt 11

User Plc[+] =+
FACU| Ty I

User Profile Groupings
Othersp—

sTarr I

Studtents , |
0K 1K 2K 3K 4K 5K BK 7K 8K SK 10K

Mumber of Charges
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4) You can now drill down to the next more detailed level by clicking on the + on the pill in
Rows or the + will appear if you mouse over any of the labels in the view.
i Columns
= Rows

Sheet 11

User Profile.. User Profile
FACULTY FACULTY
Others INACTIVE
INSIDE1S
LIBRARYUSE
OUTSIDES
OUTSIDELS
TERMINATED
STAFF STAFF
Students GRAD
GRADUATE14
GRADUATELS
GRADUATELS
UNDERGRAD

o

500 1000 1500 2000 2500 3000 3500 4000 4500
Number of Charges

duplicate'it; change UserProfile to User Profile Groupings in the View! You should get a similar

view like below

Data Analytics ¢ Pages iii Columns @ YEAR(Time Charge)

(&, DMC-charges-2014-20...

= Rows SUM(Number of Char.
2= | Fitters User Profile Groupings
DMC-Charges-by-
Tebies W FacuLTy
A Barcode Group-Year M OTHERS
e OpType Time Charge Wl sTAFF
At Station Operator L) . I STUDENTS

£5 Time Charge nill Bar
ate Title/Call No
i3]

m Fs)
ke User Catl N 4K
Calor | Size || Label
abe User Cat2
» A& User Profile Hierachy o =] 5
A Measure Names Detsd | Tooltin K
i - - - )
+ DMC-charges-2014-201 .
4 Measure Valves 3
K
|
oK |

Number of Charges.

V. Filter data from your view

Filter allows you to show a subset of the data so that you can focus your analysis. Show the
filter in the view will make the filter interactive so that end users can modify filter selections from
the view. Interactive filters are a great way to let end users interact with a visualization.

Activity 5.1 Add an interactive filter
1) Create a new worksheet.
2) Drag Number of Charges to the Rows shelf, Time Charge and User Profile
Groupings to the Columns shelf.
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3) Drag User Profile Groupings to Filters shelf.

4) Right click over the User Profile Groupings in the Filters shelf, choose Show
Filter. Now the filter is an interactive filter.

5) We can edit the appearance and functionality of the interactive filter by
clicking on the drop-down menu.

6) Rename the sheet DMC-charges-by-year-UserProfile-filtered.

Pages iii Columns @ YEAR(Time Charge)

DMC-Charges-Filtered
EX User Profie Grow.. [ (a
Time Charge IU (¥ \FA uLTY

(] othe:
Marks [v] \sw

Calor Size La
oo ] "
Detal | Toati s
3
£
III III --

7) You can also select to keep or exclude data points in the view or select
headers to filter data. This way, you are adding a filter to the Filters shelf too.
When a filter is shown, it is an interactive filter.

User Profile Groupings

Number of Charg

Activity 5.2 Create an interactive line chart

1)
2)
3)
4)

5)

Select Number of Charges, Time Charge on the Data pane

From Show Me menu, choose Line chart

Add User Profile Groupings to the Filters shelf, choose Faculty, click OK.

Add Equipment Category to the Filters shelf, choose All, click OK. Click its drop-
down menu, choose Show Filter. Edit Title -> change the title to “Select an
Equipment Category”. Change the appearance to “Multiple Values(dropdown)”.
Name the worksheet “faculty-trend-line”.
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Pages iii Columns e Charge)
= Rows SUM(Number af Char.
Filters
Sheet 21
Equipment C: Time Charge
1s0
Marks
~ Automatic - 140
w| e || -
Color Size Label 120
ato (] ~
Detail Tooltip Path w
& 100
I
£
]
&
I 80
a
E
El
=
&80
40
20
o
2014 2015 2016

Select an Equipment Category

(Multiple values) -

[nter search taxt
(Al
Audio Recorder
Camcorder
DMC KEY
DSLR Camera and Lens
Green Screen

Microphone
Peripheral
Projector

Tripod

Pages iili

Filters

YEAR(Time Char

Equipment Categ
Marks

[T Automatic -

| & =

Color Size Text

oo [my]

Detail Tooltip

Activity 5.3

Columns

Rows

Equipment C

text-table-interactive

Time Charge / User Profile (group)

2015 2016

Equipment Category FACULTY OTHERS STAFF  STUDE.. FACULTY OTHERS
Audio Recorder 3 13 50 435 10 5
Camcorder 50 42 105 756 51 16
DSLR Camera and Lens El 58 151 604 13 8
Grean Screan 11

Laptop 5 15 40 52 4 15
Lighting Kit 2 9 37

Microphone 34 27 58 251 12 2
Peripheral 5 2 32 158 4 10
Projector 7 7 29 109 6 1
Tripod 46 23 102 770 32 13

Understanding how Tableau works

STAFF
19
147
134
2
137
9
56
61
33
111

STUDE
423
835
834

5
511
30
224
191

Select a year

(A1)

2014
2015
2016

Select an equipment category -

(all) -

Enter search text

(A1)

Audio Recorder
Camcarder

DSLR Camera and Lens

Green Screen
Laptop
Lighting Kit
Microphone
Peripheral
Projector

Tripod

Every chart/view that you create in Tableau should start with a question. What do you want to
know? Every time you drag a field from the Data pane onto the cards and shelves, you are
asking a question about the data and you are forming a Visual Query Language (VizQL) that
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Tableau generates based on where and in what order you drag and drop fields into the view.
Then Tableau translates the VizQL into SQL/MDX/RQL (Structured Query Language/
MultiDimensional eXpressions/Resource Query Language) and issues it as a query to the data,
gets back the results, and renders the visualization.
An example of SQL syntax: SUM function when grouping the results by one or more columns is:
SELECT expressionl, expression2, ... expression_n,

SUM(aggregate_expression)
FROM tables
[WHERE conditions]
GROUP BY expressionl, expression2, ... expression_n;
For example, when you drag User Profile and Number of Charges to the Rows and Columns
shelf to make a bar chart (i.e. list the sum of the Number of Charges in each User Profile group),
Tableau translates your VizQL into the following SQL: Select User Profile, Sum(Number or
Charges) From DMC-charges-2014-2016 Group By User Profile.

_—~ .~
I

=
: v
somonmer

=
N =

Figure: How Tableau Works.

For every question you ask, the view changes to represent the answer visually - with marks
(shapes, text, hierarchies, table structures, axes, color).

See What is VizQL At https://www.tableau.com/drive/what-is-vizgl for more details.

VI. Use Dashboard to uncover key insights

A dashboard is a collection of several worksheets in a single place so that you can
compare, monitor, and view a variety of data simultaneously. Dashboard is all about
interactivity among worksheets.
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Activity 6.1 Create an Equipment Checkout Trend Dashboard
m B 0

1) Click to create a dashboard.

2) Click on Size, from the drop-down menu, choose Fixed, 1024x768

3) Drag worksheet of students-trend-line, faculty-trend-line, and staff-trend-line over to the
dashboard

4) Hide all “Select a User Group” filter

5) Make sure “Select an Equipment Category” is applied to all the worksheets on the
dashboard

6) Adjust some appearance settings

Equipment Checkout Trend (Interactive Charts)

Select an Equipment Cate..
500 (All)
Audio Recorder
Camcorder
DMC KEY
DSLR Camera and L...

&

Green Screen

i
&
o
2
5
§ 300 (s) Laptop
STUDENTS B Lighting Kit
o
2 Microphone
5 20 Periphera
Projector
Tripod
100
2014 2015 2018
140
30
1200
25
100
ur ur
o o
g g
s 20 5
o S Ao
FACULTY 5 STAFF 5
= =
2 15 2
£ E
El El
Z Z
10 40
g 20
2014 2015 2016 2014 2015 2016

Activity 6.2.1 Create an Equipment Checkout Comparison Dashboard
1) Create a new dashboard
2) Click on Size, from the drop-down menu, choose Range, 1024x644-1124x744
3) Drag Sheet DMC-charges-by-year-UserProfileGroupings and DMC-charges-by-year-
EquipmentCategory from the Sheets section and drop them one by one onto the blank
dashboard canvas.
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4) We can close the window of the User Profile Groupings, Title/Call No, and Number of

Charges by clicking on the Cross button.
5) Click Show dashboard title in the Objects section at the lower left corner.
6) Double click the default and change the default title text to Equipment Checkout

Comparisons.

Equipment Checkout Comparisions (Interactive Charts)

DMC charges by User Profile

5,000
4,000
3,000

2,000

Mumber of Charges

1,000

0

2016

2014 2015

DMC charges by Equipment Category

@
1,000
' L 4
g 955 989
g
g 822
bt
; 500 ® 667
g ® o
=

bt

¢ *

o H

2014 2015 2016

Activity 6.2.2 Use the top worksheet as a driver to filter the worksheets
below (add interactivity to encourage exploration)

1) Click to select the top sheet. Click on the Funnel icon on the upper right corner of

the top chart, the Funnel icon turns into White. This enables the top chart to filter all

the worksheets in the dashboard.
2) Click 2015 in the first chart, the second chart will only display 2015 statistics by
Equipment Category. Click 2015 again will cancel out the selection and return to the

previous view.
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Equipment Checkout Comparisions (Intera%‘e Charts)

DMC charges by User Profile
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4,000
3,000

2,000

Mumber of Charges
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2014 2015 2016

i B = 5 @y =
DMC charges by Equipment Category o KeepOnly X Exclude [&

4 itemns selected - SUM(Number of Charges): 4,113
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s

e
=1

822

@
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370
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Activity 6.2.3 Add an interactive filter so that users can filter data by User
Profile Groupings.

1) Click on the Down Arrow button next to the Funnel icon on the top worksheet and select
filters and then the User Profile Groupings.

2) Now you will see a new checkbox list for User Profile Groupings. Click the Down arrow
on the top border of the checkbox list and select Single Value (dropdown) or Multiple
Values(dropdown).

3) Click the same down arrow again and select Floating and drag the filter window to the
place you like.

4) Click the same down arrow again, select Apply to Worksheets->Selected Worksheets...
and select the bottom worksheet.

5) Change the filter title to Select a User Group by double clicking the filter pane and
making the change.

Activity 6.2.4 Customize the look of the Dashboard
1) Drag Blank, a container, from Objects to the top of the dashboard. Adjust its height. This
blank container will help you better lay out the objects on your dashboard.
2) Drag Image from Objects pane and drop it to the top of the dashboard (i.e. the blank
container), this opens a file selection window, choose DMC logo blue.png file. Then set it

28



3)
4)
5)

to Floating and Fit image.

?"Q?@, Insights into
=] E|
‘ﬁ?ﬁg@ Pick image...

+ Fit image
. Center image
DMC-CI Set URL...

+ Floating
Floating Order >

Deselect
g 4K Remove from Dashboard

Click on Set URL..., to set it to http://library.rice.edu/dmc

Change the setting for the dashboard title to Floating and adjust its position.

Starting Tableau version 10, you can change font for the whole workbook in one place.
Click Format in the Top menu Bar, then select WorkBook... . Try changing some font
settings with the popped-up Format Workbook menu.

VII. Use Story to present your analysis

You can tell stories with your data using dashboards or using Story function. A story is a
sheet that contains a sequence of worksheets or dashboards that work together to
convey information.

Activity 7.1 Create a Story

1)
2)
3)

4)
5)

6)

0]
Click the new Story button + or Story -> New Story
Click on Size, change it to Automatic.
You open a new story pane. You may drag your any worksheet or dashboard created
earlier into this pane.
Drag DMC-charges-by-year into the pane.
Double click Add a caption and add a caption title - DMC Equipment Circulation Data for
the Year of 2014, 2015, and 2016.
Double click the default Story title Story 1 and change it to How had the DMC equipment
been checked out for the year of 2014, 2015, and 2016? You can add descriptive text to
this story pane by clicking the A Description and entering your paragraph.
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7) Now you first Story point may look similar to below.

Story Layout ¢ How had the DMC equipment been checked out for the year of 2014, 2015, and 20167

New story point DMC Equipment Circulation Data for the Year of 2014, 2015, and 2016.
Blank Duplicate
(i) DMC-Charges-byYear-byUserProfile-Table Time Charge
(1§ DMC-Charges-by-Year o
[i] DMC-Charges-by-Year-by-Month 000
[i] DMC-Charges-by-Month DMC Equipment Loan Program had
[ DMC-Charges-by-Weekday - .
e 4500
T PEm become more popular in the past
[l] DMC-Charges-by-Year-by-UserProfile recent years.
[1] DMC-Charges-by-Year-by-DeviceName 4000
[il] DMC-Statistics-by-YearTitleUserProfile
[i) DMC-Charges-by-Years-by-UserProfileGroupi y
[@] DMC-Charges-by-Groups -
[{] DMC-Charges-Filtered
FH DMC-Equipment-Charges-Dashboard 000

Number of Charges

A Dragtoadd text

[¥] Show title

Size

Automatic
2014 2015 2016

8) Now we can add a new blank story point by clicking Blank button on the left pane.

9) Drag the DMC-charges-by-month sheet onto this 2nd story pane, change caption title to
DMC Equipment Circulation Data by Month across the years of 2014 through 2016. Add
a comment as you like.

10) Following the similar steps, we can add the 3rd and fourth story point pages. Now you

click on Presentation Mode button on the toolbar to play the story. User can
browse the story page by clicking through the navigation bar.

11) You can change Story formats like Font, Color and etc. by clicking Format in the Top
menu bar and then choosing Story...

12) Rename the Story to DMC-Equipment-Circulation-Story.

VII. Save and publish your work

Now, so far, all the work you have completed in your Tableau desktop is not saved and you
need to do it now. You can’t save your work locally. With a free account on Tableau Public, you
have 10GB storage.
1) File -> Save to Tableau Public
2) Enter Tableau Public account and password
a. DMC Tableau Public training account: erc@rice.edu
b. Password:
3) Type a name for the workbook and click Save
4) Follow the on-screen prompts to save your Tableau Workbook and publish it. This will
take a minute or so depending on your project size.
5) Now you should be taken to the Tableau Public server in an opened browser.
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6)

7

8)
9)

You can also edit your workbook right on the Tableau Public server, which is very
convenient. Or you can download the workbook and edit it locally, then save it to the
Tableau Public Server.
If you click on the Settings button, you have the option to Show Sheets and Allow
Access.
a. Show Sheets
If you have multiple worksheets, dashboards, and stories in your viz that you'd
like the viewer to be able to flip through, you can turn it on to display them as
tabs.
b. Allow Access
Let others download or make a copy of this viz.
You can click the Edit Details button at the bottom of the published Viz
External link
a. By putting a link here, when the viz is shared, it will open the viz as a lightbox
over your website. Closing the viz leads to the web page or blog post explaining
more.
b. If you leave the permalink blank, when the viz is shared, it stays on the default
Tableau page.

10) When you save to Tableau Public server, the publishing process saves both your data

and your workbook. When a Tableau Workbook is downloaded from the Tableau Public
server, it is a packaged workbook that contains the workbook and the data. These
workbooks are saved with a .twbx file extension. They are no longer linked to the original
data sources. Other users can open the packaged workbook using Tableau Desktop or
Tableau Reader, and do not need access to the original data sources.

11) As soon as a Tableau workbook is published to Tableau Public, the worksheets,

dashboards, and stories are accessible by anyone on the internet, so make sure
what you will publish is not confidential. If you uncheck “Allow Access”, the underlying
data (i.e. the original data) will be prevented from others. In other words, the original
data can be protected. The viz (i.e. the worksheets, dashboards, and stories) can’t be
protected once it is published.

12) Customize your profile

a. Click My Profile

Rice DMC -

b. Mouse over a Viz. You can feature it, hide it, download it, or trash it.
c. Select View to open the Viz.
i. Then you can select Edit Details to customize metadata such as
workbook name and description, etc.
ii. Or click Share button at the lower right corner to get a link to share
with others or code to embed in a web page
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iii. Download Workbook button at the upper right corner to download
the workbook.

iv. Download at the lower right corner to download the workbook, data,
PDF, or image.

Resources

1)
2)
3)
4)
5)

6)

7

8)

9)

Tableau Public How-to-videos
https://public.tableau.com/en-us/s/resources

Tableau Public FAQ
https://community.tableau.com/s/tableau-public-fag#subhead18
Get Started with Tableau Desktop

http://onlinehelp.tableau.com/current/quides/get-started-tutorial/en-us/get-started-
tutorial-home.html

Tableau eLearning https://www.tableau.com/learn/training/elearning
Knowledge base

https://www.tableau.com/support/knowledgebase

Tableau online help documentation
http://onlinehelp.tableau.com/current/pro/desktop/en-us/help.html

Tableau Sample Data Sets - A changing sample of datasets for use in teaching
and learning. https://public.tableau.com/s/resources?qt-overview resources=1 -
gt-overview resources

Datasets in public domain at Inside Airbnb http://insideairbnb.com/get-the-
data.html

Datasets for Teaching and Learning

http://libguides.rice.edu/data resources/samples

10)Tableau Essentials: Chart Types — Introduction

https://interworks.com/blog/ccapitula/2014/08/04/tableau-essentials-chart-types-

introduction/
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